Operaţii cu un registru

1. Crearea unui registru nou – se face, în versiunea 2003, din meniul File (Fişier) alegând opţiunea Nou (New) şi apoi din fereastra care apare selectând Registru de lucru necompletat (Blank worksheet). În versiunea 2007 se foloseşte meniul principal, opţiunea New – Blank workbook. Acelaşi lucru se poate face şi cu ajutorul butonului Nou de pe bara de instrumente Standard(2003), respectiv bara cu acces rapid(2007), sau folosind combinaţia de taste CTRL + N.

2. Salvarea unui registru 

Această operaţie se poate face cu ajutorul opţiunilor Salvare (Save)  şi Salvare ca (Save as) din meniul File (Fişier)(2003), respetiv din meniul principal(2007). Dacă registrul nu a mai fost salvat anterior, cele două opţiuni fac acelaşi lucru şi anume permit salvarea registrului, sub un anumit nume, într-un anumit loc în memoria externă. Dacă registrul a mai fost salvat Save salvează modificările făcute de la ultima salvare, în acelaşi loc sub acelaşi nume, iar Save as permite salvarea în alt loc sau sub alt nume a registrului. 

Salvarea registrului se mai poate face şi folosind tastele CTRL+S.

3. Salvarea unui registru ca pagină web se poate face selectând Save as web page (Salvare ca pagină web) din meniul File(Fişier)(2003), sau direct din fereastra de salvare, modificând tipul documentului (în ambele versiuni).

4. Deschiderea unui registru salvat anterior se face alegând opţiunea Open(Deschidere) din meniul File (Fişier), respectiv meniul principal, sau apăsând butonul Deschidere  de pe bara de instrumente standard, respectiv bara cu acces rapid. Deschiderea unui document se mai poate face cu ajutorul tastelor CTRL + O, sau cu un dublu click pe pictograma ataşată fişierului creat deja.

5. Opţiunea Iniţializare pagină (Page setup) – permite stabilirea marginilor, a dimensiunii paginii de lucru, a orientării textului în pagină (fip portret sau vedere), mărirea sau reducerea foii de lucru sau selecţia zonei de imprimat, alegerea dimensiunii pentru hârtie, setarea calităţii imprimării şi numerotarea paginilor (dacă este selectată opţiunea automat paginile vor fi numerotate de la 1). 


Secţiunea Margini permite setarea marginilor din stânga, dreapta, sus şi jos, a distanţei de la muchie la antet şi subsol şi centrarea pe orizontală sau verticală a datelor din pagină.


Secţiunea Antet şi subsol permite particularizarea antetului şi/sau  a subsolului.


Secţiunea Foaie permite alegerea unei anumite zone de imprimat, repetarea pe fiecare pagină a unor rânduri sau coloane, stabilirea a ce anume se va imprima din foaie, şi ordinea de imprimare as paginilor(pentru că pe o foaie de calcul încap mai multe pagini, fiecare pagină fiind încadrată de linii punctate).


Opţiunea Page setup (Iniţializare pagină) se găseşte în meniul File (2003), respectiv pe fila Page Layout(Aspect pagină) (2007). 


A nu se înţelege că dacă nu folosim această opţiune nu vom putea tipări date din foile de calcul, sau nu există anumite setări implicite pentru tot ce am amintit anterior. Acestea există şi se recomandă a fi modificate în caz de nevoie.   


6. Imprimarea registrului se face fie direct cu ajutorul butonului Imprimare de pe bara de instrumente standard, fie cu ajutorul opţiunii Imprimare (Print) din meniul Fişier (File) în versiunea 2003, respectiv din meniul principal în versiunea 2007. Apăsarea uneia din ultimele două opţiuni provoacă apariţia unei ferestre care permite stabilirea paginilor care vor fi imprimate, numărul de copii, imprimarea în fişier şi nu în ultimul rând selectarea foilor care se doresc a fi imprimate. Butonul Print de pe bara de instrumente Standard specifică versiunii 2003 tipăreşte direct întregul registru, fără a mai afişa fereastra de imprimare.

       Pentru a imprima documentul se mai pot apăsa tastele CTRL + P.

 
Pentru a vizualiza modul în care sunt puse datele din foaia de calcul în pagină se foloseşte opţiunea Examinare înaintea imprimării din meniul Fişier (2003), respectiv meniul principal sau bara cu acces rapid(2007). 


Stabilirea unei anumite zone de imprimat din  foaia de calcul se face în varianta 2003 selectând această zonă şi apăsând apoi Fişier → Zonă de imprimat (Printable area) →Stabilire zonă de imprimat (Set printable area). Pentru a anula operaţia de setare a zonei de imprimat se apasă Fişier(File) →Zonă de imprimat → Golire zonă de imprimat. În varianta 2007 se selectează zona dorită după care se foloseşte una din opţiunile Set printable Area sau Clear printable area, care se găsesc pe fila Page Layout(Aspect pagină), opţiunea Print area.


Un registru de lucru conţine una sau mai multe foi de calcul (obligatoriu una). 

Operaţii cu foile de calcul
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Inserarea unei foi de calcul se face folosind meniul Inserare (Insert) → Foaie de calcul (Worksheet) în varianta 2003, respectiv fila Pornire (Home), opţiunea Insert (Inserare) →Worksheet (Foaie de lucru), în varianta 2007. Tot în această variantă se poate folosi butonul Insert Worksheet situat în partea de jos imediat lângă butoanele cu numele foilor de calcul. 
2. Ştergerea unei foi de calcul se face fie alegând din meniul Editare (Edit), opţiunea Şergere foaie (Delete sheet) pentru versiunea 2003, sau alegând opţiunea Delete→Delete sheet de pe fila Home(Pornire) în versiunea 2007, sau dând clic dreapta pe foaia pe care dorim să o ştergem şi alegând opţiunea Ştergere (Delete).

3. Redenumirea unei foi de calcul se face fie cu clic dreapta pe foaie şi alegând opţiunea Redenumire (Rename) din meniul care apare, fie apăsând Format →Foaie (Sheet) → Redenumire (Rename) (pentru versiunea 2003), respectiv fila Home (Pornire), meniul Format, opţiunea Rename sheet (redenumire foaie) (pentru versiunea 2007). Oricare opţiune aleasă provoacă activarea numelui foii de calcul, care poate fi  şters şi modificat.

4. Aşezarea foii în altă poziţie. Această operaţie presupune schimbarea poziţiei foii în registru. Pentru asta se dă clic dreapta pe foaie şi se alege opţiunea Mutare sau copiere …, sau se apasă Editare → Mutare sau copiere(în versiunea 2003), respectiv opţiunea Move or copy sheet (Mutare sau copiere foaie) din meniul Format situat pe fila Home (Pornire). Fereastra care se deschide permite aşezarea foii în faţa oricărei foi din registru, sau  la sfârşit.

5. Mutarea  sau copierea foii de calcul în alt registru se face la fel ca şi aşezarea foii în altă poziţie, doar că în fereastra care apare se selectează registrul nou în care va fi copiată sau mutată foaia. Dacă se selectează opţiunea Crearea unei copii foaia este copiată, dacă nu foaia este mutată de tot în registrul nou.

6. Stabilirea fundalului unei  foi se face apăsând Format → Foaie (Sheet) → Fundal(Background) în versiunea 2003, iar în versiunea 2007 se foloseşte fila Page layout(Aspect pagină), opţiunea Background (Fundal). În fundalul foilor de calcul se pot pune imagini, acestea nefiind imprimabile.  

7. Ascunderea unei foi de calcul se face folosind Format → Foaie → Ascundere, iar odată ascunsă o foaie poate fi reafişată folosind Format → Foaie → Reafişare. Aceste două opţiuni se găsesc în Excel 2007 pe fila Home (Pornire), meniul Format.


O foaie de calcul este structurată în rânduri(marcate prin numere) şi coloane(identificate de litere). O foaie de calcul conţine 256 coloane şi 65.536 rânduri. La intersecţia unui rând şi a unei coloane se găseşte o celulă. 


Operaţii cu rânduri şi coloane

1. Selectarea de rânduri sau coloane

Pentru a selecta o coloană sau un rând întreg se efectuează un click pe cifrele sau literele asociate acestora. Pentru a selecta întreaga foaie se apasă celula din colţul stâng, situată în stânga literei A şi deasupra numărului 1.

2. Inserarea de rânduri sau coloane

Pentru a introduce rânduri sau coloane în foaia de calcul se foloseşte meniul Insert(Inserare), opţiunile Rânduri (Rows) sau Coloane(Columns), în versiunea Excel 2003, iar în versiunea 2007 se foloseşte fila Pornire(Home), meniul Insert. O altă modalitate ar fi să se efectueze clic dreapta pe numărul rândului deasupra căruia dorim să apară rândul nou şi să alegem din meniu opţiunea Inserare, sau pe litera corespunzătoare coloanei în stânga căreia dorim o coloană nouă şi la fel alegând din meniul care apare opţiunea Inserare. 

3. Ştergerea unui rând sau a unei coloane 

Pentru a şterge un rând sau o coloană fie se execută click dreapta pe cifra sau  litera corespunzătoare şi se selectează opţiunea Delete, fie se foloseşte meniul Edit(Editare) din care se selectează aceeaşi opţiune, asta în versiunea 2003, iar în versiunea 2007 folosim meniul Delete de pe fila Home(Pornire). Dacă dăm click dreapta într-o celulă, pentru a şterge rândul întreg (coloană întreagă) se bifează opţiunile corespunzătoare: Entire row (Entire column).

4. Selectarea unor celule din foaia de lucru 

Pentru a selecta o celulă cea mai simplă modalitate este cu ajutorul mouse-ului, dar se mai poate şi în alt fel, de exemplu se poziţionează mouse-ul în zona de referinţă şi se scrie adresa celulei de referinţă.

Cea mai simplă modalitate de a selecta un grup de celule este cu ajutorul mouse-ului: ţinând apăsat butonul stâng al mouse-ului şi deplasând cursorul peste celulele care se doresc a fi selectate. Acest lucru se mai poate realiza şi folosind tasta SHIFT în combinaţie cu tastele direcţionale.

5. Formatarea rândurilor. Înălţimea unui rând se măsoară în puncte, sau pixeli şi se poate ajusta folosind Format → Rând (Row) → Înălţime (Height)(2003), respectiv opţiunea Row Height din meniul Format, fila Pornire(Home) (2007), sau punând mouse-ul pe linia de sub numărul ataşat rândului şi mişcându-l în sus sau în jos în funcţie de nevoie. Afişarea sau ascunderea unui rând, sau potrivirea automată la conţinut se face folosind acelaşi meniu. Înălţimea implicită a unui rând este de 12,75pt, iar dacă aceasta se micşorează la 0 rândul devine ascuns. Înălţimea poate varia ăntre valorile 0 şi 409.

6. Formatarea coloanelor. Lăţimea unei coloane se măsoară în numărul de caractere, în formatul standard, care încap în celule, sau în pixeli. Modificarea lăţimii, ascunderea, afişarea coloanelor se face folosind meniul Format → Coloană (Column)(2003), respectiv meniul Format, fila Pornire (Home) (2007). Pentru a modifica lăţimea unei coloane cu ajutorul mouse-ului acesta se poziţionează pe linia care desparte litera ataşată coloanei de litera coloanei următoare şi se mişcă înspre stânga sau dreapta în funcţie de ceea ce se doreşte cu celula, mărirea lăţimii sau micşorarea acesteia. Lăţimea implicită a unei coloane este de 8,43 şi ea poate varia între 0 şi 255.

7. Formatarea celulelor presupune stabilirea tipului de date din celulă, a proprietăţilor textului, alinierea conţinutului, culoarea de fundal a celulelor şi stabilirea bordurilor pentru celule. Toate acestea se fac folosind opţiunea Format Cells(Formatare celule) din meniul Format(2003). 

Opţiunea de formatare a celulelor Format cells se găseşte în versiunea 2007 în meniul Format, fila Pornire(Home). Cele mai importante secţiuni din această fereastră (Aliniere, Număr, Font) au în Office 2007 un corespondent pe fila Pornire, în partea de jos.

a. Stabilirea tipului de date din celule
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Datele dintr-o celulă pot fi din următoarele tipuri: text, număr, dată, oră, monedă, fracţie, procent ş.a. Pentru a seta în celule tipul corespunzător de date acestea se selectează, după care se apasă Format Cells. În secţiunea Număr (Number) se alege tipul de date dorit. Se poate uşor observa că dacă o celulă conţine date de tip numeric acestea vor fi aliniate în dreapta, iar dacă lucrăm cu alte tipuri de date acestea se aliniază la stânga.

În cazul în care printre tipurile de date predefinite nu există un tip de date de care avem nevoie se pot crea tipuri particularizate de date. Pentru a crea un tip particularizat de date se alege unul dintre formatele existente, la care se adaugă eventuale texte. Acestea se trec între simbolurile “”. De exemplu pentru a creea tipul particularizat de date care să reţină un  numărul de obiecte folosim tipul de date număr fără zecimale, iar în caseta tip se trece textul BUC între ghilimele.
b. Alinierea datelor în celule 

Secţiunea Aliniere (Alignement) permite alinierea textului atât pe verticală cât şi pe orizontală. Textul din celule poate fi rotit sub un anumit unghi şi poate fi încadrat într-o celulă fie prin reducere, fie prin îmbinarea mai multor celule, fie prin potrivire(scrierea textului pe mai multe rânduri).

c.  Formatarea conţinutului celulelor
Secţiunea Font permite modificare proprietăţilor textului din celulele selectate şi anume a fontului, a culorii, a dimensiunii şi a aspectului. Modificarea fontului, a dimensiunii, a culorii textului se mai poate face şi folosind butoanele corespunzătoare de pe bara de instrumente formatare.

d. Formatarea liniilor celulelor
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Liniile celulelor Excel cu toate că sunt vizibile în foaia de calcul nu apar la imprimare. De aceea pentru a afişa aceste linii fie le colorăm, fie folosindu-ne de opţiunea Page setup(Iniţializare pagină) din meniul File (2003), respectiv fila Aspect pagină (Page Layout) (2007) le punem în evidenţă. Pentru acest lucru în fereastra Page setup se alege fila Sheet (Foaie) şi se bifează opţiunile Linii de grilă şi Antet rânduri şi coloane, după cum se poate vedea în imaginea alăturată.
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Secţiunea Bordură din fereastra Format cells (Formatare celule) permite formatarea (alegerea aspectului, culorii sau a grosimii) liniilor celulelor selectate, a liniilor interioare, a conturului, sau separat a liniilor din stânga, dreapta, sus sau jos, inclusiv a liniilor pe diagonală. 
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Dacă se doreşte modificarea aspectului chenarului celulelor, sau ascunderea acestora se mai poate folosi şi meniul Borduri de pe bara de butoane Formatare(2003), respectiv fila Pornire (2007). Apăsarea acestui buton are ca efect deschiderea unei ferestre precum cea alăturată, în care se pot alege modificările dorite pentru celulele selectate: dispariţia conturului, sublinierea acestora, îngroşarea linie stângi sau drepte, apariţia a două linii în partea de jos a secţiunii de celule selectate, evidenţierea conturului exterior al celulelor selectate, sau conturarea tuturor liniilor din zona de celule selectată.

e. Fundalul celulelor

Secţiunea Modele permite colorarea fundalului celulelor selectate. Pentru a modifica fondul unei celule sau a unui grup de celule selectate se mai poate folosi şi butonul Culoare de umplere de pe bara de butoane Formatare(2003), fila Pornire (2007). Această alegere va avea ca urmare modificarea fondului celulei, celulelor selectate.

8. Îmbinarea celulelor şi anularea îmbinării


Fuzionarea (îmbinarea) celulelor  presupune selectarea mai multor celule, la fel ca şi în Microsoft Word şi apăsarea butonului de fuzionare, de pe bara de butoane. Procesul de divizare(scindare) al celulelor din aplicaţia Microsoft Excel este diferit de cel din Microsoft Word, deoarece acesta nu cere numărul de celule în care vrem să divizăm o celulă, aplicaţia reface doar un proces de fuzionare efectuat anterior. În Word puteam împărţi orice celulă în mai multe, dar în Excel dacă selectăm o celulă şi vrem să o împărţim nu se întâmplă nimic.

Butoanele de scindare şi anulare scindare celule [image: image12.png]=18l
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 se găsesc în meniul Format, nu în meniul Tabel ca şi în Word. Dacă nu sunt scoase pe bara de butoane Formatare(2003), respectiv fila Pornire(2007), trebuie căutate. (pentru a scoate butoanele pe bara de instrumente în Office 2003 se foloseşte Instrumente→ Particularizare → Opţiuni,  unde se selectează meniul Format şi se caută în fereastra din dreapta cele două butoane, iar în Office 2007 se foloseşte opţiunea Excel Options din meniul principal, secţiunea Customize, iar în lista derulantă închisă se alege Home tab (Fila Pornire), iar cele două opţiuni Merge cells şi Unmerge cells se pot adăuga pe bara de acces rapid).

Opţiunile pentru îmbinare celule şi anulare îmbinare se mai găsesc pe fila Home(Pornire), meniul Merge and center(Îmbină şi centrează).

9. Introducerea de date în celule se face printr-un simplu clic în celulă şi scrierea lor sau prin scrierea în bara de formule, astfel textul scris în bara de formule va apărea în celula activă.

10. Validarea datelor permite limitarea valorilor care pot fi trecute în anumite celule, permite anumite restricţii asupra datelor ce urmează a fo tastate. Această operaţie se poate face cu ajutorul opţiunii Validare(Validation) din meniul Date(Data)(2003), respectiv opţiunea Data validation (Validare date)(2007). Validarea presupune selectarea celulelor în care trebuie introduse date, selectarea opţiunii de mai sus, stabilirea regulilor de validare, a unui mesaj de intrare  (care apare când se dă clic pe celulă pentru a se introduce date) şi a unui mesaj de eroare(care apare când criteriile da validare nu sunt respectate, adică sunt introduse date greşite în celule). Regulile de validare se aleg în funcţie de tipul de date din acele celule. De exemplu valorile numerice pot fi cuprinse în anumite intervale, textele pot avea un număr maxim de caractere ş.a.

11. Sortarea  şi  filtrarea datelor

Programele de baze de date permit efectuarea a două operaţii: organizarea sau sortarea datelor într-o anumită ordine(crescătoare, descrescătoare) şi separarea sau filtrarea datelor pentru a identifica o anumită operaţie (identificarea tuturor înregistrărilor care îndeplinesc o condiţie ).


Sortarea se poate face pe trei nivele, utilizând caseta de dialog Sort.
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Sectiunca Alinicre (Alignement) permite alinierea textului atét
pe verticals cit si pe orizontald. Textul din celule poate fi rotit sub un
anumit unghi si poate fi incadrat intr-o celuli fie prin reducere, fie
prin imbinarea mai multor celule, fie prin potrivire(scrierea textului
pe mai multe rinduri).

Sectiunea Font pemmite modificare proprictaglor textului din
celulele sclectate si anume a fontului, a culorii, a dimensiunii 5i a

Sectiunea Modele pemite colorarea fundalului celulelor selectate.
Pentru a modifica fondul unei celule sau 2 unui grup de celule
selectate se mai poate folosi si butonul Culoare de umplere de pe
bara de butoane Formatare, iar din fereastra deschisi se va alege
culoarea dorita. Accast alegere va avea ca umare modificarea
fondului celulei

EEEED e





Exemplu: Într-o carte de telefon sortarea se face în primă fază alfabetic crescător după nume. Această sortare poartă numele de sortare primară. Dacă există persoane care au acelaşi nume sortarea se face după prenume (sortare secundară). Dacă există persoane care au şi acelaşi nume şi acelaşi prenume sortarea se face după un al treilea câmp, adresa.

Pentru a sorta datele dintr-o bază de date se parcurg următorii paşi:

· se selectează opţiunea Sort (Sortare) din meniul Data (Date), respectiv de pe fila Data (2007)

· se selectează câmpurile după care se doreşte a se face sortarea 

· se bifează opţiunile Ascending sau Descending, din dreptul fiecărui câmp selectat.



Office 2007 permite sortarea datelor pe mai mult de trei niveluri. 

Există situaţii în care trebuie să se lucreze cu anumite părţi ale unei baze de date (grupuri de înregistrări) nu cu întreaga bază. Pentru a selecta un subset de înregistrări se foloseşte procedeul de filtrare. Acest procedeu presupune existenţa unui criteriu pe care liniile ce se vor selecta să-l îndeplinească. Pe perioada filtrării restul datelor sunt ascunse.

Paşii care se parcurg în procesul de filtrare a datelor sunt următorii:

· se selectează câmpurile pe care se face filtrarea, respectiv tabelele care trebuie filtrate.

· se selectează opţiunea Filter din meniul Data (Office 2003). Opţiunile de filtrare în Excel 2007 se găsesc pe fila Data.

Filtrarea este de două feluri: automată şi avansată.

Filtrarea automată

Opţiunea Autofilter se găseşte în meniul Data, opţiunea Filter(2003), sau pe fila Data, opţiunea Fiter(2007).  

Aplicaţia Microsoft Excel citeşte fiecare înregistrare din baza de date şi creează o listă de criterii de filtrare pentru fiecare câmp, în cazul filtrării automate.
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Sectiunea Modele pemmite colorarea fundalului celulelor selectate.
Pentru a modifica fondul unei celule sau 2 unui grup de celule
selectate se mai poate folosi si butonul Culoare de umplere de pe
bara de butoane Formatare, iar din fereastra deschisi se va alege

10

prin imbinarca mai multor celule, fie prin potrivire(scricrea textului
pe mai multe rinduri).

c. Formatarea confinuului celulelor

Sectiunea Font pemmite modificare proprictatlor textului din
celulele sclectate si anume 2 fontului, a culorii, a dimensiunii 5i a

Words:

B worda
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Pentru a vedea aceste criterii se apasă pe săgeata din dreapta numelui câmpului. Criteriile prestabilite apar întotdeauna la începutul fiecărei liste.
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Pe lângă criteriile predefinite listele mai conţin toate valorile de pe coloana respectivă şi alegând una dintre valor se vor păstra doat acele înregistrări care au în celula de pe coloana respectivă valoarea aleasă.


Criteriile predefinite sunt următoarele:


Toate (All) – se setează când nu este utilizat conţinutul câmpului pentru a limita numărul de înregistrări afişate.

Primele 10 (Top 10) -  se foloseşte la câmpurile de tip numeric şi se selectează înregistrările corespunzătoare celor mai mari zece valori.

Definite (Custom) – utilizat pentru a construi un filtru pe baza unor criterii ce nu apar automat în listă. 



Pentru a  crea un filtru personalizat se parcurg următorii paşi:

- Se selectează orice celulă a câmpului pe care dorim să-l filtrăm.

- Se alege opţiunea Custom (Definite) din lista derulată cu criterii de filtrare, pentru a deschide caseta de dialog Custom AutoFilter.

- Se stabileşte operatorul pentru primul criteriu.

- Se selectează primul criteriu din lista derulată.

- Se stabileşte operatorul pentru al doilea criteriu.

- Se selectează al doilea criteriu din lista derulată.

- Se selectează una din opţiunile And sau Or, în funcţie de preferinţă. Dacă se alege opţiunea And se vor lua din baza de date acele înregistrări care verifică ambele criterii, iar dacă se va selecta opţiunea Or se vor lua toate înregistrările care verifică unul dintre criterii. Nu ste obligatoriu să folosim ambele criterii pentru filtrare.
Formatarea paginii

Comanda Page Setup, de pe fila  de lucru Page layout, este folosita pentru specificarea formatarii paginii în care se va lista foaia de lucru. Fereastra deschisa are patru sectiuni:
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Sectiunea Page (Figura 1.2) configureaza orientarea paginii (Orientation) cu optiunile Portrait si Landscape, diferite tipuri de ajustare (scalare) a foii de calcul pe pagina (Scaling), fie procentual, si prin precizarea numarului de foi pe pagina, dimensiunea paginii (Paper size) si calitatea la imprimare. Tot în aceasta sectiune sunt prezente si butoanele pentru tiparire (Print) sau previzualizarea documentului înaintea imprimarii (Print Preview).
Sectiunea Margins (Figura 1.3), seteaza marginile stânga, dreapta, sus si jos pentru pagina de listare a foii de calcul, tinând seama si de spatiul alocat pentru zonele de antet Header si subsol Footer, precum si centrarea continutului (tabelului) în pagina, pe orizontala sau pe verticala. 
Sectiunea Header/Footer - aici utilizatorului precizeaza textul, sau conținutul care va fi scris în zona de antet, cât si în zona de subsol, oferindu-se si setari predefinite.
Sectiunea Sheet ofera un set optiuni privitoare la foaia de lucru si anume zona care va fi listata - Print area (prin precizarea domeniului din foaia de calcul), posibilitatea repetarii unor linii din antetul tabelului sau unor coloane, care se vor repeta, pentru fiecare pagina de document (domeniile Rows to repeat at top si Columns to repeat at left), optiunile de afisare a liniilor de ghidare sau ordinea paginilor în document.
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Figura 1.3 - Setarea marginilor
Figura 1.4 - Sectiunea Header/Footer
